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Molar Extinction coefficient 11250

1 A[280] corr. to 2.48 mg/ml

A[280] of 1 mg/ml 0.40 AU

Isoelectric Point 8.13

Charge at pH 7 3.72
Amino Acid(s) Number count % by weight % by frequency
Charged 83 36.68 32.55
(RKHYCDE)
Acidic (DE) 25 10.85 9.80
Basic (KR) 29 14.43 11.37
Polar (NCQSTY) 90 34.08 35.29
Hydrophobic 67 27.06 26.27
(AILFWV)
AAla 11 3.02 431
C Cys 25 9.33 9.80
D Asp 11 4.51 431
E Glu 14 6.34 5.49
F Phe 16 8.14 6.27
G Gly 21 4.85 8.24
H His 2 0.96 0.78
[1le 7 2.83 2.75
K Lys 13 5.85 5.10
L Leu 21 8.48 8.24
M Met 3 1.38 1.18
N Asn 12 4.88 4.71
P Pro 18 6.38 7.06
QGln 12 5.40 4.71
R Arg 16 8.58 6.27
S Ser 22 7.12 8.63
T Thr 17 6.24 6.67

REREA ARG D

3
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V Val 11 3.97 431
W Trp 1 0.63 0.39
Y Tyr 2 1.12 0.78
B Asx 23 9.39 9.02
Z Glx 26 11.74 10.20
X Xxx 0 0.00 0.00
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........ I
Fragents <[] end
| taa | =]
LS B hen A BT ek AR et ,a;%s’;a:ﬂ 5

T f{fLEL v LR A A e link 6 4
e

4o DNA &+ - 3R o
BT R d o F s -
your vector NTI session » 27z % (OK ) R BF -

-12 -
RN i o S B

% iE - BT

A
54
v

Copyright 2003 All right reserved

feature - 3%

BALT B P AW %37 this will end



Vector NTI User Manhual

¥ -~ % Molecule Operations

p e ¥ pBR322 ¢ general data » feature map © and sequence & {7
¥t (LR F0 F{r DNA & 3 gk (£ 8 - $keh)

% 4% Vector NTI #2 ;¢

7 pBR322 ek AR (423% vector NTI->Exploring local
vector NTI Database>DNA/RNA Molecules (MAIN)->PBR322 » #
F o)

— . %t pBR322’s 1% * T (general data) it {7 ¥nif

birfd % cnd b & o B PBR322 BN TG § v
Edit pBR322

General DMA/RMNA Molecule l IJzer Fields ] I:Dmments] Ke_l,lwu:urdsl

" Lircular o DMA

" Linear " RMA

Estra-Chromozome R eplication

[+ Bacteria [ “Yeast [ Animal/Other Eukaryotic

Replicon Type

[+ Plazmid [ Phagemid
[ Cosmid [ Winus
[~ Phage [ Chromozsome

Dezcription:

ATCC 377, ATCC 31344: Cloning vectar plagmid pER 322, complete genome.

)4 | Cancel | | Help |

% PBR322 4r M4t B keywords > 23BN OB AET AT ¢ 6~
My own plasmid > 2t Add  # 5] DNA/RNA Molecular % » #-5 T
¢ description ® I F ik 2 My pBR322 - 8 OK (/£ %)~ i1k
¥ehZ b & pBR322% > A PBR322chis G 4 — B & 55 3P LAk
(hE 1% 2ci§ I PBR322 c AN PR AFTHEY EFie- L%

Wy S

=y

- 13-
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# it % molecular=>save as> &3 I ¥E S B P B3~ B e

r':f‘
My pBR322 » 8 OK » (SfF 3 A L7 L7 » M 5% ¢ ® 5 5 T4
Be o Eﬁ?r}—'@‘.a B¢ >~ PBR322 E’ﬂ/’JDNAAo\—S-’ﬁ B - B R4

¢ PBR322 (ﬁ{ﬁgz}w}fﬁ’é FPRB ) ¥ - B ,Tﬁ;{}k %73 078 B my
PBR322 -

Z . Y%iE My pBR322’s & 7]

Fads B3 % 0 7 i % edit-Dset selection » A B¢ 5~ 5 7
21-40 > 8L OK - ¢ % BEFEF®RPM z 3 Clal fo Hindlll = B 4] ps
*7 i+ o BLiE ¥ i¢ & edit2>new—>Replace Sequence 21 bp—40 bp » #-4L &
P % 23424 A TC R A B AA B > AT RHT 4o

Replace Sequence 21 bp - 40 bp

i | [Eapy | Faste | Eind... | K, |

Cancel |
21 TCAAAGATAL GCTTTAATGC
| inzerted 2, deleted 2 || before 26 bp " |

: inserted 2 > delete 2 - 8 OK » ;iR &

I—-,E,\:K“ﬁ-‘lﬁ' :',"_ ﬁ‘-gﬁ:I'J)i
7 o 4o BlAToT -

J‘:l e Clal lﬂg‘l}-__ xJ }J =3

- 14 -
RTREAFPARLGT 2P

N
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i~ Wector NTI - [My pBR322 *] ==l x|
[#) Molecule  Edit Wiew Analyze Gel List Align  Assemble  Tools  window Help — =1 =]

2 B o eep o [[S S 0 B S0 225 BB R D PR
Actlve Pane: |3 fali] 5T

= %] My pBR322 - -

- P EcoRTiazeal,
amd T 1 General Description =
~ 5D sEQ P dTIT (20
- [ Standard Fields - P b
Pl - |
Edit Del [ Original Author Apatiteaza, T (v
2 Comments npr
Mods:
Design = [ Feature Map PaT i Ter
# ] Restriction Map
R _Iv _Iv
EcoHI

AAGAGTACAL ACTGTCGALT CATCARATE GTGTCAATTT AACGAT.

________ 101  GOGCTCATCG TCATCOTOGG CACCGTCACC CTGGATGCTG TAGGCATAGS CTTGGTTATG COGGTLL
CGCGLGTAGC AGTAGGAGCC GTGGCAGTGG GACCTACGAC ATCCGTATCC GARCCALTAC GGCCATE

201 ACAGCATCGC CAGTCACTAT GGCGTGCTGC TAGCGCTATAE TGCGTTGATSG CAATTTCTAT GOGCACK
TGTCGTAGCG GTCAGTGATE CCOGCACGACG ATCGCGATAT ACGCAMCTAC GTTAAAGATHA CGCGTGH

1 TTCTCATGTT TGACAGCTTA (GGTAGTTTAT CACAGTTALD TTGCTAJ'

301 CCGCCCAGTC CTGCTCGCTT CGCTACTTGE AGCCACTATC GACTACGCGA TCATGGCGAC CRACLCC
GGCGGGTCAG GACGAGCGAL GUGATGAACC TCGGTGATAG CTGATGCGCT AGTACCGCTSG GTGTGG

________ 401 GOCBGOATCL CCGGCGCCAC AGGTGCGGTT GCTGGOGOCT ATATCGCCGA CATCACCGAT GGGGLAC
CGGCOGTAGT GGCCGCGGTG TCCACGCCAL CGACCGOGGA TATAGCGGCT GTAGTGGCTA CCCCTTC

77777777 501 GTTTCGGCGT GGGTATGGTG GCAGGCCCCG TGGCCGGEGE ACTGTTGGGC GCCATCTCCT TGOATGH
CARAGCCGCA CCCATACCAC CGTCCGGGGC ACCGECOCCC TGACAACCCG CGGTAGAGGE ACGTACT

G601 CAABCCTACTA CTGGGCTGCT TCCTAATGCA GGFAGTCGCAT AAGGGAGAGC GTCGACCGAT GCCCTTC
GTTGGATGAT GACCCGACGA AGGATTACGT CCTCAGCGTA TTCCCTCTCG CAGCTGGCTA CGGGALC

| I ””” 701 GCGCGGGGCA TGACTATCGT CGCCGCACTT ATGACTGTCT T(i TTTATCAT GCAACTCGTE GGAC, i’c{i_l'
4 »

Fragments 4| »

Ready 21 bp - 40 bp (20 bp) | 41 bp (3 | |

# My pBR322 thig sc % Bif > 3 i n 3| FHE

AREA B ¥ FE L & MypBR322 gm0 G- TL%%
Bl rr i % By o BRIE At
= molecular——Revert To Saved » B OK Fx %_o pt p& FofL B Hh] 4 e
B R BT o (Ar&k T & 3 2 st % P & molecular # ic & P iF
save as & % )

B 3R Y R

s SR
,}1
=
=
I
&
T
SX
2
4
r
ik
S
P
94

¥ AMIBERZ| NPT & AR IR 3~ - BLATISH -
BERFHcE 7 B FE 7Y o AP(R) 2 (3293 bp—4156 bp) v
TC(R) 35 ( 86 —1276 bp ) » # it % edit>Set Caret Position ° ﬁi%] »
200 #5445 T 200bp S T o PR A f:ﬁ/@ﬁ ~ 10 B T &k A -
Bt7 ic % edit>new—>insert sequence 200bp » A IR E S B P ﬁg?]
~10B T 8 0K» R8¢ - BHZEIH PRI EmNg o
B 7e &gz (CDS TC(R) is affected by sequence editing > Delete °
Delete All » Keep > and Keep All) » 2 keep.¥ 12 % I . 200bp 5 7]
Fed 7 10 B Te AP RF RS AP (R) > PHRE 2§ 2 g
PF4-45 7 10 Bk 2 (3303 bp—4166bp)e HF » A m4s 7Y - L3
Mo BB pg PR B LR R o ok 4
R 7 K - R Faap 38 Vi B Keep 0 NTI ¢ p &% 3734
o AN PRI RS I TCR e FIRE e SEH 7 10 Bk
& (1286) 23 5’# 33 X B o 4T BlHTow

-15-
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£~ Yector NTI - [My pBR32Z &l x]
@ Molecule  Edit Wiew Analyvze Gel List align Assemble  Tools  Window  Help = |
~ ]| B [k =" 3] A
2@ Balgox 33 T8N 0% ERER QN
Jnctive Pane:
t:l |:€:| My pBR322 - EcoRT (azpal F1 P ;I
y - 50 SEQ TaTizs:
add M _1 General Description P p = S
tol 23
i 3 [_7 5tandard Fields dgaTiiasea oo
Edt  Del (2] Original Auther opr HT iz =
g 2] Comments e TCr
Mode: :
Design _1 Feature Map
(] Restiiction Map [ cos TCiRY 86 bp - 1286 bp (diect) |
ey | [ |
Hindll -
EcoRil Clal
1 TTCTCATGTT TGACAGCTTA TCATCGATAR GCTTTAATGC GGTAGTTTAT CACAGTTALAR TTGCTRACGC A
ARGAGTACAL ACTGTCGAAT AGTAGCTATT CGALAATTACG CCATCALARTA GTGTCAATTT AACGATTGCG
101 GCGCTCATCG TCATCCTCGGE CACCGTCACC CTGGATGCTG TAGGCATAGG CTTGGTTATG CCGGTACTGC C
COCGAGTA AGTAGGAGCC GTGGCAGTGG GACCTACGAC ATCCGTATCC GAACCAATAC GGCCATGACG G

Lol

ACAGCATCGT
TGTCGTAGCE

CAGTCACTAT
GTCAGTGATA

GECETECTEC
COGCACGACG

TAGCGCTATA
BTCGCGATAT

TGCGTTGALTG
ACGCAACTAC

GACTACGCGL
CTGATGCGCT

ATATCGCCGA
TATAGCGGCT

LCTGTTGGGC
TGFACAACCCG

LAGGGAGLGT

CAATTTCTAT
GTTLALGATA

TCATGGCGAC C
AGTALCCGCTS G

CATCACCGAT <
GTAGTGGCTA C

GCCATCTCCT
CGGTAGLGGL

GTCGACCGAT &

01 GCTTTGGCCG CCGCCCAGTC CTGCTCGCTT CGCTACTTGE: AGCCACTATC

CGLARCCGGC GGCGGGTCAG GACGAGCGAR GCGATGAACC TCGGTGATAG

M0l  ACGCATCGTG GCCGGCATCA CCGGCGCCAC AGGTGCGGETT GCTGGCGCCT

TGCGTAGCAC CGGCCGTAGT GGCCGCGGTE TCCACGCCRA CGACCGCGGR

1501 ATGAGCGCTT GTTTCGGCGT GGGTATGGTG GCAGGCCCCG TGGCCGEGGE

TRCTCGCGAL CRARGCCGCA CCCATACCAC CGTCCGGGGC RCCGGCCCCC

01  TCAACGGCCT CAACCTACTA CTGGGCTGCT TCCTAATGCL GGAGTCGCAT

— AGTTGCCGGA GTTGGATGAT GACCCGACGA AGGATTACGT CCTCAGCGTLR

Fragments 4 I ’I LI

Ready

. ik TC(R) BT

R B TR en TCr e § REE RS 7 Ak I (
¥ BF B w4t > iE feature properties ) > e di R eNEFIE S MY ® ¥

201 bp - 209 bp (9 bp)

ITTCCCTCTCG

CAGCTGGCTA _cl;l
13

| &

210 bp (37

"
-

1113 e TCreni= ¥ ~ Gfifods it o AP %24 (name) ¢ TC(R)zc =

Old TC(R)» #4 15 f b

=

™

inserted” - - OK - RIRIA) S %~ ¢

-16 -

N\

RERELFPRERGF TP

11 description ¥ éig?] *Fa ikt “10 bp fragment
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PeoR 1 (43709 1P

SD SEQ fa 1(25)

P3P Hind 111 (309
P2P
Bam H I (386)

Old TC(R)

[ COS '01d TCR) 86 bp - 1286 bp [direct] |

My pBR322
1371 hp

I. P P2 Pt o> T x ZT0RE S HGE T
i

—_—

wRIHEP 45 3] P2P > E P~ > LU Bl 4 5 i Delete Feature From
Fmap ( & 'ﬁ/’ff‘f\edit Pk v EHELEL ) P NTI #4571 P2 Pwill
be deleted from the feature map » B OK (FxT_)° "3 LB % » P2P
St T o T AP PBRI22 B A4 - (B ATHELfE

edit>set selection%ﬁi%] »~ 3000-3500bp > B-OK » 1 E 71 ¢ 35 3]

E‘ (add features ) ¥4z > 8T o (» ¥ 11 j§¥_edit>new—>add feature to
FMap & » ) o f 213 %38 = Bl feature name iic?] > New Feature »
AR NTI 403k Zendd g 4] (feature type ) B Misc. Feature » & #
HFE U EI A Y EH R L LY ke &S E OK e 4rF

£ Wector NTI - [My pBR322] =] =]
@ Maolecule  Edik Wiew Analvze Gel  Lisk  align Assemble Tools  Windows  Help _|ﬁ||£|

| =2d@adosm R TR XL BB |DPA R
Jnctivepane:

i %] My pER322
J o = 1 General Descriptiv Eeall fazrat, PP
1 Standard Field 50 SED SaTizm
(L) b andard Fields P3P ndTIT (33}
Edit ol (1 Original Author Apallieaaay e HT (s
o # Comments BPT old TorR)
ode:
Dresign 1 Feature Map P T ima
(1 Restriction Map
1 ] Annotations
Hew Feature My PBR322
azritp
Te——zaTllaz
ApatTiamEy
ORI . 30 SEQ
L v EFF ROP
dpa LT {zmaay H ' EFF
| 50—
Hindill i’
A
EcoRl Clal
1 TCTCATGTT TGACAGCTTA TCATCGATAL GCTTTAATGT GGTAGTTTAT CACAGTTARL TTGCTAI
AGAGTACAL ACTGTCGAAT AGTAGCTATT CGAAATTACSG CCATCARLATA GTGTCRATTT ALCGATT
i TS < e e T i e e
Ready 1bp | |

-17 -
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< § # My pBR322 g & ﬁ%@&ﬂﬁwiﬂ:ﬂﬁ%
molecular——save as > (4% # iz %35 ) 8 OK » NTI #-4% 7+ My
pBR322 ¢ 55 & > ¥ F % F ° B overwrite.

2 . 8z My pBR322 =45 A 1

TR F R KA 3E > 9 10bp B e 4~ cHPBR322 & 5 - Rk iR
oo FoA & Molecule%operations%Advanced (DNA/RNA)->Change
Starting Coordinate o # ! %35 = Bl new start(Frerdz4n2hix )ﬁi%]
~ 11 (FIEKIA4FE~ 7 10bp > 42488 1+10=11) - B OK >
PUPENTI € 427 % o A e AR B £ 7 84> BLOK AT - Mt
e @k TsRE Y TCR iz ¥ @ ;_égrvk 7 (76bp-1276bp ) - & H
AP (R) #hiz¥ (3293 bp—4156 bp) » &8 frd4- 1 PBR322 - i -
i -]

P1 P
EeoR 1 (43600 e 1151

=D SEQ Hip A IIT (20

F3P FZP
Apa LI (40354) FamH 1
AR

Por T (3612)

| CDS '‘aP[R]) 3293 bp - 4156 bp [complementary]

My pBR322
\\ 4371 bp

FNE AT o B NTI

Menwwy Fesature

-18 -
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LA >

% = ¥ Graphical Representation

P et U DNA A S K 6 $44 3 BB 7 e 4k 1% (35
EE T/F’f\-" DNA # 2 )» & pBR322 B|A5&& > - BE T4 T > & %337 I
e

— . A pBR3R2 BAiE > - BETARE

1. % 4% Vector NTI #& ;¢

2. xh@—v‘r%ﬂg«#?“ PBR322 (& # Fh:‘a‘;ﬁ?#ﬂ?‘%;‘ﬂ%?%}‘ﬁ),
NTIi?r’v",‘!iéijé”l_fl ﬁxﬂém#F’“ i?‘c(él—‘ﬁ
molecular——Open) f3 e17 Open % v ¢ ZhiE database

o

DNA/RNAs > #5714 ¢ :}51“ R322 v 7R 18 OK

3. BT AT 3 B 4o PR LR B it e
A5 b R ’i‘&}:}i’ff‘;.{ﬁ¢€v SGEPEEY

:‘l
A ctrl ke B ﬂé«él ( Standard Arrangement ) > & *
Jffl#gﬁmmq iAo K E I B e dnfod A ]
:&»‘ B‘ .'L °

/

= . BB % % G 5 ( CDS signals ) %

BLY R ER MR CRPE ) RERFRH B0
T4 & ¢ > iE CDS Display Setup > i * ¥ 4 {58 21 ¢0 Graphics
Display Setup ¥+3& = B¢ 12 2509718 % kf % SRR A S AR s EEen
feimE > (F ¥ P NTI BRIk (dF 7 )o (8 % —‘F’i‘ ¥ 143 i BE more
keiF L fenigec (WArF Mo | F > o word ® F R R (%4p
) ez is- B OK BT 3 ¥ o A3 e N E4 AT 0

"

RN L RN A R
-19-
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WA N PR EEE L B d o T o AP iR
(display setup) + nd
Settings As » R 1S 3 ) ik :
*blue’ BEOK > /L & 2 PFFNTI €477 &7 FrH s 2% Haoh

2ENO » 3B f BhiE (d1splay setup ) + Bl ] = & A5 FELA G £
FIblue @ ST R A °

TR S SR

NTI % #7 & BHIER ¥ 0 35 0 A3 ik 55 (R4 )W

BEES N o fads B E A %;’;:}%-_I (edit plcture) Fede o RS gEY

W57 e R RS R R BT R

properties(/ia']”})ﬁ\?—‘ﬁ style(h )% ’35‘-??;—»/{;1 VLR RE b f
B i chi 6 P HiRse @ 3 AHBA S ( foz_ w973k en E'?'fﬂ%év\

+’%i%“@’ﬁﬁ%ﬁﬁﬁﬁ?ﬁﬁfﬂﬁﬁﬁfﬁ

SN

TCR) B~

#-TCR)SEEH = ff &

e (e4o™ o ogLY ﬁl#%éa B¢ TCR # 8 > L B4 iF
properties>fill » 3%+ B = N EH ¢

Properties

Line  Fil l Shape ]

Fill
oo -]

] % | Cancel | Help

220 -
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2t OK
2. 2+ TC(R)% ¢

2@ TCR {8 % i R AR g B dpr. ¢ 0 Mw%’l/ﬂ’"-

am|

fe W R R T ORI AR BT ek
BREpHEE (BIFIP SR &r%t’iﬁ&g:}%lﬁ]%ﬂﬁﬁé’
¥ ) A 4% A ctrl+shift B oo d SRE R Y E 0 B0 R A
AL WIEH gD Aok Bigaa ¢ e R Y 5=

> ’ 2 Y a2 ~ ] E_':I ~
FALT 2 o FREBRYT J‘l:}%_lﬁ’»‘/ﬂ ,Ae T B -

FeoR 14360 P1p
SDSEQ

i 1{25)
e Hind T {20
Apa LI[4034) Pz R
APT

BstI(3612)

FamHI{3T6)
TCr

Ava 1{1426)
Apa LI{2755)

QR 505EQ
L% EFF ROP

Apa LIF2290) H Y EFF

3. B TC(R)fhze chfe ¢
il B 2] TCr fhie ) o BEF - BIR T G S0 M (GRUR T

Text ] Line |

Substitutions:

| &=k zignald/enzymemotif  molecule name - Insert

Font. ... | Arial Bold 2
Ok I Cancel | Help

221 -
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EL Font » ¥ 4% 4148 18 523 » 2. OK » TCR #-4 7 4c ™ M)

NP FHE @é«_l (Standard
Arrangement ) Fdz 0 @ e h R Ew FEE R > ok B e K
iz s NTL:E ¢ 7 RREFender 4.F B LR T o

AT = N L RER : :

'ﬁf'}#ﬁ,?l—ﬂ?d&" IPJFT’ “f"f f:*":ﬁ,l /J» ’,[ﬂ\.LU ('QV%/J»F)@

@éﬁl fo L BRie WA EL) o Al f'?’ﬂi'%?" TH g “Clone into
pUCI19” > 2L OK o ptpF4e » ciji §§ ) F]l%]m:‘ Lo R

TCr eh T & ¥ (7 %ﬁ‘ﬁééﬁ’&;propemes PEE TR ﬂ}r'

g )o 4T B

i B A 7 be (L f2 > BR3¢ 4 edit->Delete Annotation
PR M Biren W Ao chh w0 NTL X 7 ;; #1322 e
IFRRES > 9 r K0 PUERAE L AT

!
‘b —
‘}'}E_‘:J rﬂ&—i—,»”‘ Ei%"&f’%tﬁﬁ E/I%E‘fjgé"\/a

F4
o @;n\:\-

o]

e
T

= . ¥ pBR322 A~ F k2% B3I &¢

# it % Molecule>save as>save as file & F NTI @ 584247 >

-2
REREAFFHLGF AT Copyright 2003 All right reserved



Vector NTI User Manual
:ﬁ{ﬂmﬂhﬁoﬁﬁﬁﬁ%ﬁﬁﬂﬁ’%OKo%%%zﬁm1g

= eiblue > ¥ 2 é_f%ﬁ'éﬁ:‘%:}&é Blenz & 3 4o:F H blue o M FF %
S g T TR hml v B 5 AT 0 B yes (@RS T 2 fop)
i i internet {7 R T )L XY PR 2 T A M 2
HAoFaa FaE? fF - R L RAFTHRED o bR F
GRS~ FMOS LR (R R FAR ) MAERY FT AN
e idggiRis i %TF?;“%%? VIR O RAcT A E Y Pk 2
Pl (AP FRE- A AR I RATHER G s S
(wdaeie ® F AR p ¢ e & f & fik &€ GENBANK T e
IR RS TR R ek BB e E B R e RIS S B 5
FHREY g )

19 dr 4 N
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%z ¥ BLAST Search

BLAST(Basic Local Alignment Search Tool) #_rZ - £ DNA & &
§ WA REHIG HDNA & Fd FAFI TR ki F0E 0 o
- #8732, % Vector NTI ¥ &1/ internet i 4% NCBI (National Center for
Biotechnology Information) % ¢ * NCBI " BLAST #25% % & 7| L &
% i {7 v¢ 4 NCBI ¢ Genbank *7iz & «&_p % % = A 2 # (public
domain)DNA % 3-v B R 7| T4 &% 3 BLAST W 7 45 & TR E
¥ 27 query 5 7] £ F R {4 (homology)sh 5 51 35T k¥ ikt 1% AlignX
BEFSEAT AT o B Jﬂu‘ v i%iE %K P 7 0 BLAST SERVER
k14 Vector NTI +* $H4+ 4 B 7| FHLE o

= .BLAST #&% 4%

Vector NTI g 3% 7 BLAST search engine &_i>* NCBI website
(http://www.ncbi.nlm.nih.gov/blast/blast.cgi) ° & * Jﬁ vl BdaoM B ok EL
BLAST Search 4L % ° 4™ Bl:

B\ (12 e

o .. [ Took
€] Read Me
&7 3D-Mol
% Alizn¥ Blocks
& AlignX

uch

i BLAST Tiewer

N (5 B » B Citation Viewer

m Adobe Acrobat 5.0 37 ContigExpress

> Microsoft Excel @ Dratabass Explorer
Microsaft Word License Manager

(5} Ulead Photolmpact4 0 * 8] PubMed-Entrez Search

» (5 HP PrecisionSean LT 858 * (5] Remote Data Sources Wizard
B Vector NTI Suite 7 4 ;ﬁh Vector WNTI

(5 Wg_FTP

(5 Lhead Nexa

BiE || @ [ W &3 7|| EINT VT Chin | SuReEE - o, | usBiz | & rbecoatey- .

¥ - B > e 58 84 Vector NTI 25 & 4258 B & Hen
BT i S NS b4 2 R BRI, Y chE B CDS, £ d

Tools>BLAST Search ¥ B ET4l % 4o

9

9

B

.
5
24
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Canel

2l
—Range
= Whole Sequence \LI

{* Cunent TS feature
e |
— trand
+ Direct
" Complememntay

“Eﬁ}“ T F F UTiE PR 7| g A4kt kg 7 BLAST Search, @

+
T~
B # &5 7| BB~ sequence page ¥ ©

%TkngUTmE

BLAST Search

Choose BLAST zerver:

" NCEI QOBlast
= NCEl Web
" Other [zpecity URL)

| ]

# OK, ¢ HIT 7R T

Seaich 1 - BLAST Search [NCBI Web server]

Search “iew Help
| b5

“ELAST 20 j Program: Iblastn j D atabase Inr j @ Submit

Sequence | Paramelersl bd atrix I

Sequence:
ATEGGTGTGAAAATTTATAEMAETGTGE‘AGTAAGAGGTATTGAAAETGEGGGTGGTAAAATETETGATGTGGTGAGTGAGAAAGGGGEGATTA;I
At CETCT CAAGT TG TACTCGCTGGRGEGTATCTGGTCGCGTTTAT T TATGGGCAATAT GG TAT TRATAT CCCAACGLTCAATGTATATCTATCA
CAACAACGT GTCTCAGGGGRTTCCT GRTGCACCACG T GETAATGTGCAT T TACCTAATGETAT TCAT TTCCGLGAACAAGLAGATG R TACTTATGL
CGTTGCACCACG TATCT TTACGAGT TCAATAGT CAAAGATAG LT TCCTGLTAGGECCTAAAT TTATGLACT TATTAGG TEGCGGAGAGT TACCGT
TGEGAATTCTCTATTRGTGAAGAT CTATTTAATTCAT T TAAAATGLCGACCT CT TREAAT TTAGAT GAAAAAACACCAT TCGAACAAT TCCGAGTTG
CCACG GLAACACAAAATACGCAACACT TAGAT GLTGTTTTCCAAAGAAT GAAAACAGAAT TCCCAGTAT T T GAAAAAT CAGAAGTTGTTGAACGTT
GGEGGRTGLCGTTRTGAGT CCAACATTTGAT GALT TACCTAT CATTTCTGAGG T CAAAGAATACCCAGGLT TAGT GAT TAACACGGLAACAGTGTG
GGEGTATGACAGAAG GCCCGGCAGLGGGT GAAGTGACCECT GATATTGTCAT GG CAAGAAACCTGTTATTGATCCAACGLCGTTTAGTTTGGAT
CGTTTTAAGAAG TARACCCTTGT T T TACT GTAAT TASACACAT TAAGGAGT TTTCATGLGCTATAAAAGTCTACTTGTTGCTTTACCTTTEGTGTT

CGGTGTAGCAAGT GLAMAT GLAGCGGAGALT GTTRTGCATCATAAAT TAGACG GTATGECTAT T TCAGAAGCAGT TGAAAT TAAT GLAGG -
Mame | Status | Request ID | Hit count | Date & Time |
AAD gene seaich Finished S60502670-13371-24553 16 (06/08/2000 18:21:25

Search 1 Request erar [I0 nat assigned) 0E/07/2000 12:45:50

<

For Help, press F1 [

g & ¢ search engine 4_ BLAST 2.0, &£7™ k¥ i&
Program fr& vt $ g 4L B e
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Application |Query [Database Description

blastn DNA  DNA |7 DNA #% DNA F# E o
blastp Protein Protein |4 protein % protein 7 # E o
blastx DNA  [Protein |2 DNA 4% protein F# E o

tblastn Protein |[DNA " protein #7% translated DNA T AL E |

tblastx DNA  DNA #-DNA # ¥ = = B reading frame {7
¥ = > I reading frame s7 DNA 3L

B o
Menu Identifier Description
nr All non-redundant GenBank sequences and CDS

translations

EST(+  human, | EST (Expressed Sequence Tags)
mouse, others)

Others includes all organisms except mouse and

human

GSS Genome Survey Sequence, includes single-pass
genomic data, exon-trapped sequences, and Alu
PCR sequences

HTGS High Throughput Genomic Sequences

PAT Protein sequences from the Patent division of
GenBank

Yeast Saccharomyces cerevisiae protein sequences—a

database of sequence fragments of the Yeast
complete genome

Mito Mitochondrial DNA sequences
vector Vector subbase of GenBank
E. coli Escherichia.coli genomic CDS translations
month All new or revised GenBank CDS translation +
PDB + SwissProt + PIR + PRF released in the
last 30 days
226 -
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2 Sequence Page i€ * f ¥ 14 key in =% copy/paste & & +- ¥ eh 5
7| & select Search=> Open % = B & L $4 e 544 o

% Parameters Page ¥ 12 % kX T #F ¢ parameter °

E__'E Search 1 - BLAST Search [NCBI Web server]

Search Yiew Help

ID2Ee - = =52

JIBLAST 20 j Program: Iblastn j Database:lnr j i Submit
Sequence Parameters |Matrix I
Expect: hd Organism limit: INDHE j
Filter: ILOW complesity j' Query genetic codes: ISlandard[1] j

™ Ungapped alignmetit

Other advanced options: I

E xpect value for inclusion
in PSI-BLAST iteration 1:  Pattern:

|u.uo1 |

Expect & &% & *UF| #7135 | B 5| enfp A2 B 2 F X455 L %
A BRRENEI|T T EF, P EBAFLR T FFRE o

2

Matrix Page ¥ 12 % 3% @ * 4 E# % * chmatrix table, iz ¥ &t

H30 PRI R, A0 BLERR TR

E__'E Search - BLAST Search [NCBIl Web zerver)

Search View Help

[DeElE = &
JIBLAST 20 j Pragram: Iblastn j Database: |nr j @ Submit

Sequencel Parameters  Matrix |

I atrix:

I atris Gap existence cost | Per residue gap cost | Lambda ratio

L= v

BLOSLIMEZ 1 (.85 default

ELOSUM45 14 2 087

Pabd30 7 2 040

Pabd30 g 2 0.86

Pabd30 5 2 087

Pabd30 10 1 091

Pak30 9 1 0.87 recommended

Pabd30 g 1 0.7a ﬂ

BLAST Options—7# 12 i View —>Options { ¥t option, »|4c# ¥
display =% 7| # B ,£ # OK
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Options

— % Use automatic retrieval of BLAST results

Checl Ready statuz each |2 :II min IU :II B0

— Clueny options
Limnit the: number of retrieved BLAST hits to 500 -

— 1 Ovemide default Intemet settings

= Ditect connection [no proxy server)

& Connect through proxy server

Addiess:  |hprosy Part; IBU

Ok I Cancel |

% 3] BLAST Search Viewer, @ Submit|m 4o BLAST search,

= . BLAST Search Results

¥ 118 #&d BLAST Search Viewer F = El“é BLAST #.% ¢ % &
¥&x A EH 3 BH BLAST Viewer o & & d B 422> # it & 2> Vector
NTI=>BLAST Viewer 37 B % —JF,: BLAST #7i% eni& &% 7 1/ #fé—@ KEL
BE, EFREFnRE RV IRUEVFIT G RE

& DLAST Rosuls Viower - WD genosemrehl =]

.@' BLAST Results  Edit Wiew ‘Window Align Analyze Assemble Tool: Help 8|

=2 2R EE S ane

[&] AAD gene search - +280 S;ﬂgern:e
= Query: molecule
Length: 1800

= & Hits: 16 molecules
=1[#] gblU35383.1IPMU35383 (3 ¢
Molecule: Prateus mirabilis amino acid 0:1 e 1800
Length: 1800
C1Score: 43 [Bits: 85.7). Ex
C1Score: 35 (Bits:  69.9). Ex
] Score: 1654 (Bits: 3279.0).
=[] dbil4R030003.1)AB0O30003 ! ) Hit Distribution
Malecule: Proteus vulgaris LAD gene |
Length: 2147
C1Score: 17 [Bits: 34.2). Ex
C1Score: 14 [Bits:  28.2). Ex
® 71 Senre: 1R (Rite: 32 21 F: =

-54.1

I 600 1200 1300

H: 1 . 1800

<]

Consensus AATACTTATTTCGACTCTTTTGTTCCACTTTATTATC AATAGG
Query sequence | 1| AATACTTATTTCGACTCTTTTGTTCCAC TTTATTATC AATAGS
gblU35363.1IPMU35383 | 1| AATACTTATTTCGACTCTTTTGTTCCACTTTATTATC AATAGS

|gblU35383.1PMU35393; Score: 43 [Bits: 85.7), Expectation: 0.0 G

= * 4_BLAST Viewer 1 Text Pane, 2w ¢ 7 & B &

fei
=1

£
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Query % ‘J’%mff%p&ﬂg & Hit ™ & ?f‘fﬁj“ o ey B, !
Bl s 6, 7R EY £ 5 16 i K 72 query & homology > ¥ 14 i% 4% H
- BRIEFMELIRE 4’5&?&%“3@@ & query M ¥HATE v
F WP o 2EHEH Y a0 hyperlink, g p#-ziE AFld NCBI =44
k. F ,aa*ze’* Vector NTI 3= & %

Bt JEIE A A Query A7) SHEY R SR
P E A GER S| ¥ endp AR R rrlri"lf PO ] §o ffﬁf’j\
5 7)) 8 query ﬁ};l AR % M %™ 2 P E_
Balaizg a3 (Fd)ER7(d )2 query s 2 & &
BB o BT 3 enil§ R query 2 TE 4E DR S 2 B T 7

H

e
e
; ‘5;

- . Saving BLAST Search Results

& 7% T BLAST search 9% % :¥ Blast Results=> Save As & a‘%@,.
% ¥ 1275 & Vector NTI database =% & BLAST result file, 4=~ [&]:

Save As... 7]
BLAST Results Filee  Databasze BLAST Results |

Look i | (] BLAST Flesuls [MAIN) =

& paTHZ1_01
[&lpaTHz 02
&Rsa16_01
EREmERY

BLAST Result |02

Ok I LCancel |

E/E F AR EL R OK T
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Save Ag .

BLAST Results Files | Database BLAST Hesultsl

Lookin [t () -l Bl &

|| Prezentations __|5lideshw __IVecContD ata

|__|Program Files | zoftdack __I'rti Documentation

|| QuickTime __15sbm __|¥nti5. Bzergei.e

| lrasmol __155BM archives __I¥NTIE.ORHprojects

|__|Reports __15sbm2.5 __1%MTImisc

|__|RaoboHELP Office __15uite B __IWVNTISUITEprogramfilas

|__| Robohelpfiles __15vnaptics | ¥ircom

|__Izhared L 1Tools __|BLAST Files...

K| [+

Filename:  [BLAST search 052400

Filez format; IBLAST Search Object [*.bso) j

Ok LCancel |
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¥I % AlignX

- BERHR

4 B]>* NTI 2 Database Exploer ¥ £ P~#7& 2 K 7| D BLE + = 2.
Align—-> AlignX-Align Selected Molecules

J DMASRMNA Molecules

> Ahg;ﬂ{ Orpen Mew 2 lsament Window
J == - § | % @ | ’- Alizndt Blocks - Alizn SBelected Folecules %?
[&411 Eubhasss - 52 AlignX Blocks - Open New Alignment Window

DMHAS/RMA Malecules [MAI; Multiple Sequences on BCM Server... uthor 1Cipd o A
& 53 =1 Two Sequences via S1M on ExPASy Server. . MENCWHN UNENCW
S test = . e IENOWN — UNENOW
Gl CTLAS 451 Linear Basic UNENCOWN — TNKNOW
57 clecsin 444 Linear Easic UNENCOWH — UHENOW
5 pPBR3224est0406_$Constn F10 Linear  Basic OHENOWI  UHENOW
1 sfp 255 Linear Basic UNKENCOWN — TNKNOW
o3 433 Linear Basic UHNENCOWH — UHKNOW
=P o4 490 Linesr  Basic UNENCOWN — UNENOW

) f24 Linear Basic UNKENCOWN — TNKNOW
fadl ioae 184 Linsar  Dasic UNENOWN — UNKNOW
= IL14 81575 Linesr Basic UNENCOWN — UNENOW
i =] ABO105TA 2517 Linear Basic UNKENCOWN — TNKNOW
= pas-1 [=|ABO23132 870 Linsar  Basic UNENOWN — UNKNOW
B HIV — 235 Linear Basic UNENCOWN — UNEKNOW
EHin 2071 Linesr  Basic UNKNOWN  UNKNOW
sy E: (] ABO23135 2610 Linear  Basic UHNENCOWH — UHKNOW
=il o 1 A TiAnenc 1TMn T e PR P TR N T TTRTLAwT AT

VNTI ¢ B fc AlignX AR & 3 4% » #TiE P2 K 7] » 4o §

B Untifled - =10l x|

Project Edit View Abgnment Align Analyze Asemble Tools Window Help

R 5@ v
Lctive Pane: {% iGar e Yl

AATE3522 [451) -
AA193102 (444)

AAZE0749 (310)

AAZE1790 (255)

AAS01155 (433)
_[®]AA517416 (490) =l

[E=|
[
[E=|
[E=|
E3]

positives: 0.0%  [identity: 0.0% &
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EBRTREFT LR DEE 2 2 Alignment>Align
¥
Selected Sequences

B United - Al =

Project Edit ¥iew | Alignment Align  Anslyze Asmemble Tools Window Help
=k BTN
J = H & Align Selected Using Profile. . | | [%
g —F

Active Pans: g;%,m Heleeted To Alignment Ko |

T ] [ Show Dot bt Plat...
PVRT e o] 2] shou Similarity Table.
SR [ Alignment Setup...
AA361790 [255)
AAS501155 [433)
AAB17416 [490)

Align Selected Sequences |positi\-'es: 00% |identit)r: 0.0% | | é

B Untitled - 4 =0l x|

Froject Edit Wiew Alignwment Algn Anelwee Assemble Tools Window Help

|BE|el&a | F @RS QN

Letive Pane: m J IZF; f’é‘ ﬁ‘ i(\ | H
AA163522 [451] -
AA193102 [444) |
AAIE0749 (310
1 Aa361790 (255 lustal W Progress
E1 Aa501155 (43 % Group 4 of 6
AART7416 (490

B B B

-+ -+

[
Ready positives: 00%  [identiny: 00% | = 4
FEAE B PR AR TS 21 T8 TG el 0 BER AT R
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Pro]ect Edit View Algnment Algn Analyee Asemble Tools Window Help

=10lx]

| 2E

3 S|@

Es

Lctive Pane: ’@

\@@@wﬁﬁﬁ

3[#] AA163522 (451)
£[H] AA193102 [444)

Phylogenetlc

EE RN

Graphics 45179

Tree >

#0743

2|

|

o0

—»

400

Py

Similarity  w

E00

200

II ‘lll |ih ' | Complesi

Absolute

Absolute

T L AARDNSS
Alignment ’

Complesi

[BAIE352
_I—d

460 470 430 430

48360749
AA3E1730
44501155
A8517416

TTA--TAGGAATTGGGCACTTALGGAL- AGCTTCATAAJU. GCCATT- GGTGTTGGA © TAGGATj
CLAACCATTCAAGTGTCGCTGTHGGAAGAGTTACAAGACLGC TCAGGGCCTGCGHCA-CCACAC R;_l
TTT-—-ATGAAGCTTTCTTTCAGTGCC CAGTGLCGGTARL- - ACATATCCAGC TGAGTCCATTC A
TTA--CCGGCACTGGECACTGALAGAL-AGCTTCATAAALAGCCATTTGRAGTTSGAGTTGEGAT ™

Congensus

TTh CAGGCA TGGGCACTGAA GAL AGCTTCATALALL GCCATT GGAGTTGGA CTAGGAT

Kl

J

H

positives: 34.2%  [identity: 34%

|er: 241 |

=

B Fz Similarity Table £ Dot Matrix Plot:

i P~ Alignment—>Show Similarity Table ¢ Show Dot Matrix Plot

Similarity Table X
EEEREE
A41 53522| A41331 EIE| MBEEI?4EI| AA361 F’EIEI| 245017 55| AAE17A] E| AABEI63T
241635220 100 I G4 46 29 6 73
24133102 100 GG 7 G0 65 26
24360749 100 74 56 74 9
24361730 100 57 53 LN
245017155 100 6 13
24517416 100 o4
b |AABGIRIF | 100
g 7 o ¢ o
Close

R R I
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18, Dot Matrix X

Matrix Edit View

|FaXEEQS @ N

‘_> [44163522 52 I B FYAEET =l
N BATEIE22

4404

1 53 105 157 209 261 N3 3/ NT AN
Beady 1 1-440 | 1- 447

v

e o7 0F L M 5 & BioPlot 22 AlignX 2 4 > i AlignX
e % ¥ iE {7 BioPlot e 47 o

*> Alignment Pane § [f] > View—> List of Analysis >E BT
=0t o
B Untifled - & =10/ %]
Project Edit | View Alignment flgn Analyze Asemble Took Window Help
SR Zoom In = [k
EF 1348 @
Zoom Dut
Active Pane:  Zoom To Selection % @ '@l ’E i |
————  Fit T Window ——
&APA' Similarity s
q v Show Vertical duis [
— | Show Legend
Place Legends Below Flots
APM- . Absalute
Edit view layout... Complesity ]
AF Maccimize Pane LI+-F6
Activate Alignment Pane Fo
L APA1_PIG | i 70 WO 20 |
1L 10 20 30 40 50
'A1_BOWIN 1 HKEWLTLJLVLFLTGSQJ‘.RHFHQQDDP—QSSUDRVKDFETVWEJ&IKDSGRDWJLCﬁ
Conzensus 1| HEAVYLTLAVLFLTGSOLRHFUOODDE QOSPWDRVEDLATVYVDAIEDSGRD YV AL
K i
Open list of analyses |1J03itives: 006% |iden1:ity: 12.3% |gr: 5 .

< 4
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=10/ ]
Lovailable analises:
Hame | dnthar | Refersnee Eﬂ
Fi9 Absnlnte Complexity Informa, Ing Vector NTI S ﬂ
Fiod Bninn acid eomposttion (95 i the . Bairoch 4 Release notes for
Fiod Bntgenieity vale X 10 Welling 3 W, . FEBS Lett. 183:. i jA
i L o wedght ratio of hetero eleme . RERAEIRN Arience 185802
1| | ’ —
Antigenicity
+ value £ 10
Selected analyss:
Hame | Sequence for analy:
Lz, Stmilarity Consensus
L, Absolute Complexity Aligment
L, Antigendcity value X 10 Consensug Huydrophabicity
1, Hydrophabicity (elts 612 cal) Consensns " ||“ dels G2 cal) o
« | 2 L =
40 50
ﬂ = ﬂ ﬂ 0K | Camsl | hrvrvEaIRDSGRDTVACH
WTVYVDAIEDIGRDYVAC
I | [ ol
2 s »% = I .
SR T EAHE
1. Alignment £ *3%k %_:
i# P~ Alignment—> Alignment Setup
B Untided - & =10/ x|
Broject Edit View | Alipnment Align Analyvee Assmble Tools Window Help
- L AT
] + = Alizn felectd Requences | G |
=y | Ll o
=1 & ilign Selected Using Profile. ‘ ‘ %
ot Pae: {231 | & 40 Seleoed To Alignment oY ’E i
Q’M‘l 63522 Show Dot batroe Flot... Similarity  a
gA.M 93102 Show Stmilarity Table. .
— Align
Abzolute
AA193102 Complesi _|
AAIE0743 - ;
AB3ET730 4 o
ALBOT155 3 | [T TIT1T ) Iﬂm
4G 7416 v 1 4
460] 460 470 480 430 500 ELL
24360743 | 145 TTJL——TJLGGILJLTTGGGCILCTTMLGGJLJL—AGCTTCJ‘.TJLAML—GCCJLTT—GGTG';I
AA3E17I0 | 81 CMLILCCJLTTCMLGTGTCGCTGTGGGJLAGAGTTJLCJ‘JLGACILGCTCJLGGGCCTG';I
Corsensus | 460l TTL CAGGCL TGGGCACTGLL GAA AGCTTCATLRRL GCCATT GGAG
Kl [ A
Llignment parameters sstup |posi1ives: 34 2% |i:ien1:ity: 4% |g:r: 20 | 4
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Algnment Setup ﬂ

Paivis Aligunent | e Agwrent | Tee | Seoe Mt

[~ Use FAST algorifhon
K-tuple size; I'E_
Nusherof bedtdigonale [
Window size; |4_
(yap penalty: |5_

(rap opening penalty: |
(3ap extension penalty; |I5.I56

e | @ | 58 |

VG R AR R TR T BT A RRUE B R -

2. Alignment Display Setup :
¥ BB Alignment Pane 2 # [F] € 13 Alignment Display Setup

Aligmment Display Setop £|

Consensus Caleulation | Similavity Tables | Color Setup |

[T Consider only dentical residves i consensus caleulabion;
[T Ignore gaps in consensus caleulation

[T TUse smouence &5 consensns:

L4163522
44193102
4.4%60749
44301750
44501155
44517416
4 4509637

Eesidve fracton for consnans: IEI. [

e mE | =Aw | e
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L ligmment Dizplay Setop ﬂ

Consensus Caleulstion | Similesity Tebles  Color Setup |
—Resdues

B
Conmrvative

Block of sinlar

[dentical

Wealkly stmilar

Foregrovnd Backgroumnd:

—| [

—mample
TRSEELQENESLYOSTRE AFEDMNGFAIDOTI DY AS
ToOAFGNTENREYIVETIEE AFRDGHGFNLEVINYE TR
MO YRYCETOAV AP LEE AF RDONGFNLEVINYE QE
ToOFEITELFO3LQD IREAFRDCHGYNLEIVNYELT

3 mE | =Ew | B

3. Plot Setup:
** Alignment Pane 2 #= Bl > #f K 42030 ¢

NI F B R R P RE - B A T S B
IGENES A
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=

LA

% W74 |'||| II ". |
1 bl 400 00 ac
J Similarity
=| = Ak i
AM—— ZFoomIn | .
1 Z00m Cut | ] i
& Compledity
Zoom To Selection
* Fit To Window
: 72 v Show Vertical Aoz , .
1 00 ar
|7 Bl g miplesity [BA361730)
v Place Legends Below Plots
6} Print Preyiew
730 7! &3 Camer. . 820 30

Similarity P
Anabysis  Datagram

— Personal graph properties
v Ehow tndividnal avds

oi0is 2.

Alignment Pane # B 7|z #7)EEF o d F TR

UERREER LT T HEITEZ 2R
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Edit Alignment : # &+ # 33 £ Alignment % %

** Alignment Pane 2. # f] > View—> Edit Alignment

Edit Alignment il

Select a block on & squence and v amow buttons to maove it by inserting, removing and resizing zaps on itrends:

AP&1_BOVIN |MEAVVLTL AVLFL TGSQARHF WoQDDP-03S WDRVKDF ATV TVEAIKDSGRD YV AQFE =
APA]_CANFA|MEAALLTLAVLFLTGSQARHF WOQDEP-QSPWDRVEDLATVYVDAVEDSGRDYVAQFE
AP&1_HUMAN | MEAAVLTLAVLFLTGSQARHF WQQODEPPOSFWIRVED LATVTVIVLEDSGRDTVSQFE
e | ME AWV L TL AVL Filgyesienisiguislogs - 03P WD EVEDF ATV VD AIEDSGRDYVAQFE

Move Selected Block: '?El él E?l 2?" o [0} Kl Cancel | ’WI
[Ready [ [sel: 13-27

7

SN ol DAL )

1. Alignment ¥ #»’ﬁ%l 4
a.*> Alignment Pane # > Project>Print ' Z 4238 p 222 FEr 50 o
b.* Alignment Pane #= ] ->Edit>Camera->Format £ P~ Text & ¥ F @?J di e
—2>Forma % P~ Metafile l%]lliﬁg?l 41
Camera® 25t i 5 #-FHAGH T pbE? - 7 B £ 2 2104
Word > PowerPoint % i& {7 $if o

2N E o P27 BA R T Y 7 ou Camera 2o # it ﬁé’s—?ﬂ‘iiﬁi%] dr
iR o ?7}»’%?1 M2 R M EE P2 Pane 3 4 o

Phylogenetic Tree 2. ﬁt@iﬁﬁ] !

** Phylogenetic Tree Pane 2 # [l > View>Export Phylogenetic
Tree—>Save File °

PAET R R
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% AlignX-Blocks
G R ol Rl i

1. 4oB]** NTI 2. Database Exploer ¥ iEFB~#7& 2_ 5 5| > BLiE
> 2_ Align—> AlignX Blocks-Align Selected Molecules

@ Exploring - Local Vector M TI Databaze - | O | El
Protein Edit View Analvee | Alion Databaze  Lssemble Tool: Help

J I [@] Frotein Malecules £ AlignX - Align Selected Molecules

Align - Open New Alignment Window

| 2 BIZ@ES) . R

(All Subbases 4 Align Blocks - Open New Alignment Window
Pratein Molecules [MAIN] . Multiple Sequences on BUM Server... e Type | Author ﬂ
¥ apolipoprotein [Z] Twwo dequences vin 314 on ExPASy Server. . Infarbdax, 1
ﬁ] bacilluz J e ITIT LTI ITILIN T Inforbax, 1
il Prion LPA]1 BOVIN 265 Basic UNENCOWI
clE? LPA]1 CANFA 266 Basic TNKNO
S A1_HIMAN 367 Basic UNENOW]
irwettase ¥ 265 Basic UNKNOW]
P protease inhibiter .ARDE ECOLI 120 Bag;: Inforbda, 1
P wansportsse [ BAAZ1473 222 Basic UNENCOWI
7 TBE EProt [s] BAAZZ4TO 313 Basic UNENCOWI

o | BALITIE0 587 Basic UNENOW]

fall CTLAA blasts hit || | )

=" TR

|Open Alignd Blocks windove for selected molecules v

2. VNTI ¢ B fx AlignX Blocks AL & ' §% » “TiE Br2 B 71 o4

- 101 x|
Err:uject Edit Lggemble  Tool: Window Help
e —— r
j I:Eﬁ\ @S G ﬂl&llta-?
Have Pro]ect
Active P T = | 1] ‘ 2w || @
_[#] APA1_BOVIN [265]
_ [#] APA1_CANFA [266)
_[#]APAT_HUMAN [267)
_[&] APA1_PIG (265)
4
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3. FBITREF AT B A DEE 3 20 Blocks—>Search for
e
Blocks ==

ARHEFRF o AT R

4 Untitled - Algn¥ =|0] =
Project Edit View | Blocks Align Anslyee Asemble Tools Widow Help
] | * oy = (b
2H el s Flla 3@
Define block  ChltB
Pt P } Editblock..  CtltE B e ﬁ
T Delete block
_ t?hliink CtiltL
) & UM il
[El aPa1_PIG Uulat: )
Align¥ Blocks Setup...
Rearch selected sequences for blocks 4
cha -|D|ﬂ
Project Edit Tiew Blocks Align Analvee fsmmble Tools Window Help
I (RN A == 5 | b
2= AR E e P Y= 1
. —F
x|
: Seanning each disgonal for blocks (diagonal
924 of To45)
][] ]
Ready v

4. RN E Y BRI TS 21 %8 T2l 0 B2
BEA4oT B
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=10l x|

Project Edit ¥iew Blocks Align Analyze Lssemble Tools Window Help

|2E et H i FERaan
Lctive Pane: o ﬁ” i““ >fm ﬁ

= & [&] APA1_BOVIN [265) 120 180 240

Text — =] APAT_CANFA (266)

[ R p—
= 8[@]APAT_HUMAN (267) | ams1 HMaN

Schematic T[Z[APAT_PIG [265] HPAT_PIG —

|n3me|m| lenlMP—sc... ﬂ
Block Lisc 12> | o Teimd
AP&1_CANFA

) 179 4168
I8 ;

170 401 e AW_HUMAN
) 160 amox)|  APAIFIG
4 | | 3

'81_BOVIM |

{aoth

4
_._1
Alignment i

S REE RHAK

1. AlignX Blocks #& * 3%k 2_:
i P~ Blocks=2> AlignX Blocks Setup

=l0(x]

Project Edit Tiew | Blocks Align Amslyze Asemble Took Window Help

Pasametess | Blocks' coloes | Score matrie
S|y [ = it AR | | |
Define block  Ctil+B
Aictive Pane { Editblock..  Ct#E Padnvise score cutoff: IE
L ™ Delebbmk <4—
mafglaparpoy— | |1 S0 100 s 200 S0 Min. sequences per block: |3
[@]APAT_CAN @ Link Crhl .:==
DT I e I Bigeetstionvah linit [0 0001
#4[B] APA1_PIG Uikl e
i 60 ki
ridskiincfeasalykhlnlkl Ldnwds Ly
[ = /| :
Llign¥ Blocks parameters setup 7 TE I i | £ |

VR E R L AR He TR RE R § R RS
B o

2. Edit Block : # #& % Block 2 { #z Block gg ¢ -
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%> Block List Pane 2. q%? Fl » iZ P~ Blocks>Edit Block ﬁ

Eljlt E ].I:u::]:.'_ il

APAT_BOVIMN [ 32| drvkdfatvyveaikdsgrdyvagfeasalgkglnlkl ldnwdt last Lakvt
APA1_CANFA [ 43 dawvkdsgrdyvagfeasalgkglnlklldnwdslsstvtklreqigpvtogett

1M Length MP-soore  BP-score  Significant?
Restore to o
original | original: 4 179 4163 25001 yes [0 0e+000)
current; 2 179 7730 773 yes [0 0e+000)

block meme: Iudl | : 7
block color: I|:| ,I Caneel

3. Edit Color : { &z Text ergpd o
*+ Alignment Pane 2. gsw FIpN 0 :E B~ View—>Edit Color

Edit wiew lageout. .. ——
bdasimize Fane Al+-Fa h

Activate Text Pane Fo APAT BOVIN

Linked text color: auntorathc - I

Sample

aygbggs————— SGYSLRLecnt——GDNI3wvottkostriwvg
cogvwpalig————— PYLSGLEr ivngEEAVPgswpworrs 1o
gL eagqrnswPI0ISlgyrsgsswahtooggt Lirgnurs
rddddkivogyt CGAN TV y————OWSLN=sgvyhfogogs1i

LT e R R

i Cloze Cancel I Lpplar I

4. Link Setup : #-i=>t7% = % 2_4p%g 10 Blocks 71|+t g
f -

»+ Block List Pane 2 # [ » i P~ Blocks>Link

-43 -
REREAFFHLGF AT Copyright 2003 All right reserved



Vector NTI User Manhual

g =] (0] %]
Project cks Align Anmalyze Asemble Tools Window Help Project  Edit ¥iew Blocks Align Anelyse Assemble Tooks Window Help
JB.||| & Seuch for ks =35 @k J =R S = i
Define block  CtltB
dctive P [B]] Mook Cobd Jmmpm- ElEISIE “ G
L= Debteblck
[ —— o |1 A B0 la0 160 200 240 & 5[] APA1_BOVIN (265) | [ [L. A5 0 138 180 225 200
APAT_ EAN APA1_CANFA (266) | 2751 BUVIN ]
hm N

APAT_HUb D el APAT_HUMAN (267) [y T ent
@a[@apatpig L [ 3[B] APAT_PIG (265) BPAIPE | | e——
= I
0| B Alignll Blocks Setup.. q 0|
el B
O 4 137 O 4 1,
9] 4o @] PRt I
R - o M APET B0V
@] 4 1 's) P K
- W—— OMMOmER T
© o o 4 1o APAT_FIG
o e o
| D ‘ »
Link selected area Ready

1. Alignment F #iﬁi%] a
a.>* Alignment Pane 2_ # [f]> Project>Print  * 5 25\ p &2 5| F
st o
b.** Alignment Pane 2. # f] > Edit->Camera > Format :% B~ Text = ¥ F
CE
—>Format iE P~ Metafile 3
Iy %}
(MMmaiﬁfé%?%%%*@%%ﬂ’Pﬁ”ﬁiiﬁ
7V 4 Word > PowerPoint % & {7 ik o

TR ¥ 2 Camera 2o # it B3
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- . R H =

1. 4 B3t Vector NTI B35 ¥

s ¥

BioPlot

Y

%

N

L

EBTR LS 72K D8k

Analyze—>BioPlot-Analyze Selected Molecule

NTI- 1B14_HUMAN

Molecule Edit ¥iew .An.al el

El 1B14_HUMAN

[ Annotations
1 Analysis

[:I Author

[Z7] Original Author

List Align Assemble Tools Window Help

Active Pane: ’7 ;W ﬁ:l BioFlot - Open New An.al}rzer T ind o
7| Protein Scales (hydrophobicity ete ) wia ProtScale on ExPASy Server. .

Protein Becondary Structore wia NNPFEEDICT. .

0] Standard Fielc Protein Sequence Propertiss via SAPS an ISREC Server...

=" Protein Beguence via Peptidebazs on ExP A Sy Server. ..

- = Protein Trmmnembram Regwns wia TMpred on [EREC Server. ..

g Comments
[ Feature Map

TWVDDTLFVERF
DLETLLEYYM

DTELVETRFA

LLLWZAVALT ETWAGIHIMR YFHT3IVIRPG RGEPRFITVG

THYTHHF ISD HEATLRCWAL GFYPAEITLT WORDGEDOQTO

GDRTFOQEWAL WWAWPIGEEQR ¥YTCHVQHEGL PEPLTLERWEFP
Open Sequence Analveer window for selected 1 115 aa - 206 aa (92 aa)

207 aa ()

2. VNTI ¢ P ¢z BioPlot 4R %

,

S

4 Bl

_—

fr 2 24735 A A

prote =lol x|
File Edit View Analvee Align Asemble Tools Window Help

| @ |

JAcﬁve Pane: Z@E

[2]1B14_HUMAN (361) Hydropathicity

-

1B14 HUMAM
> C1G I Descrip
Text o
omments
[_1 Standard Fields irgiireosp:to:ri‘cga
i determined by
naysm & e}[{r;l[\é y |
eature an
Plot e |
Sequence

NTFLYFTR

"

RE R L PR

Pa

>

SHRTEAEWNL & INAIPSCFROAR

B

¥

VTOHVAHFAL
128 aa (65 aa)

PERLTLRWUFR

64 aa.- 120 5a =
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Analypzis
Length 361 aa
M olecular “Weight A04E7.33 m.w.
1 micrograrm = 24.715 pMoles
Malar Ex=tinction 81380 -1.38
coefficient 1
1 4[2380] corr. to 0.50 mg/ml +0.503
A[Z30] of 1 2.01 Al
maral
lzoelectric Paint 5.86
Charge at pH 7 -6.36
; . Humber % by % by
Amino Acid(s) count weight | frequency o
Charged [REKHYCDE] 118 33.89 3269 1
Bricdic INET 47 1413 1302 =l <]
Turn_5  Turn_E Turn_%
it S S
Helix_2 Gilyco=ylation_1 Strand_5& Turn_7 Strand_& Strand_7
101 DLETLLRYYN QSEAGSHTLG NMYCEOEcRL.LAGTHOD AYDGEDTIAL

4. Broadcast Selection :¥ #<E B2 E 7| H T IR A B2 4258 ¢ >
4 Vector NTI - iE B~ B 7> View—> Broadcast Selection % % 4r
B -

3 or NTI - 1BE14_HURAR _ II:IllI A TE /1E14_HUMAN - BioPlot
Maolecule  Edit View Analvee (el List Align  Asemble Tools File Edit | ¥iew Analyze Align Asemble Tools Windc
Windaw  Help J o Show Both Strands = (b {
— =} [l
SE i =P

EFERERF

...... __[len
1 Com [v Fommatting Mode
314_HUMAN (1 Star

¥ 1814 HIE

] General Ana Edit Pane Layout...

11 Standarc
][] Annotatii Molecul  Switch to Text Pane  Fo

1 Analysis 1 micTi;l i 0 160
1 Author L ] LLI 3 4 >
[Z1 Original 4 -

. M, ATE
Active Pan Tamslate complementany, = Lu Q |
Eraze Translations _

sipalt

Length Mawimize Pane  Al-FS

Turn_9  Strand_2

1 HMEVTAPRTLL LLLWGAVALT ETWAGSHSMER YFHTIV

20L RAYLI

Strand 11

151 aa - 178 aa (28 aa
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5. { :TZ #4ci7ens 453 2 (Analysis List) :

i P~ Analyze—> Analysis List
# > Protein 7 +4&) -

S>E Bt g 2 A 45 2 (DNA ~

Lyailable analyes:
Name | Authox | Reference | ﬂ
Fi Byndno acid composition (99) in the .. Bairoch &, Eelease notes for SWISS-PROT releas. .
y e H Welling 3 W, .. FEBS Lett 188:215-218(1085).
J Atoomie weight ratio of hetero eleme .. Grantham B Bedence 185:862-864(1974).
Fea bverage area buried on transfer fro.. Fos G.D, Gesl..  Science 220:824-838(1985).
.f[x]lﬂvemece flexibility fndex Bhaskaren B, P... Int I Pept Protein. Ries. 32:242—255(..._|;|
1 3
El
Belected analwmes:
Name |
ls, Hydropathicitr
[z, Hydrophabicity indices at ph 3.4 determined b HPLC
|z, Average area buried om transfer from standand state to fal
|z, Average flexibility index
| =l 2| = 0K | Cancel

6. BioPlot # A3k Z_:

% P~ Analyze—>BioPlot Setup

~ Analysis list QK |
Betup...

b - - Cancel |
— REUENCE
— Feature Map

¥ 3K E_4K & ot 2. Feature
- Beftings
Load from file... mave fo file...
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Fhiap Setup

X

L1 kinds of features will be displaved in the text and

~Nucleotide ETENCE )% graphics panes. Add here the kinds of featores you
0 want 1o see in the sequence pane:;
Langlh of blocks: Cl [ Cholestern] Biinding Site ﬂ
, : . 89 Cleavage Site
Blocks per Ling: 3 Coiled ol —
@4 Collagen-type
. [@9 Conflict
~ [anslation [#9 Comnecting Peptide
[eg cUB d
(" [ -Lefer Ak Code ~ - -
Tou may also ]Jm.ﬂ the length of featores 1o be displaved in
(¥ J-Leter ik Cade the sequence pane:
|4EI {Enter & nurnber or leave this field blank)
PR E R AR Em AT R ELRD

7. Plot Display Setup :
F S E#F Plot Pane ¢ -

LatTRlZ R E NMEA AT E 2P

0

/i

Cancel

< add .

= Remoye

B e,

=5 Remove Al

Fooko®] o I F gy iR By PR EREYI - B ATHR] T 0
LB

Hydropathicity FIEF 5 [ - ropathicity FIES x|
Analysis |Datagmm| Analysis  Detagram |
Hame: Hydropathicity Personal graph propertie:
futharis: Kt I, Doolitle R F. ¥ Show individual axis
Reference: ] Mol Biol. 157:105-132(1982). -
. Fisusl type: ineas
Comments:  Last modified 15bdar/1996 by ELG
Threshold: [5
(h d average M . D 01015 @M 2.
d el valie: 10 Color. | E— -
Window size: 51
Name | Value [ -
W Ala 18
W Arg 4.5
W A 35
W Asp 35
W Cys 25 ;I
e | Ea | =Re | meE | g | mm | =Ee | HE |

8. Plot Overlapping : & & 5 I~ 178 -

. %% Plot Pane 2 #
Overlapping’E
LR A B E R

R L O

3R

kl > View—>Edit

o
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from TRL witi:proteindl B14_HUMAN - BioPlot -3l x|
File Edit | ¥iew MAnalyze Alizn Assemble Tools Window Help

J [Z;’El_sva.amamm §||%@

Zhow Legends
Aotive Pan g,a Place Legends Eelow Plots El | @|@ QR a”_”_ﬁ =t
e @ Properties

[2l1B14_
1B14 Huh @) ZoomIn
1 Gen EL Zoom Ot
(2] Com =}, Fitto Window
[:| Star &4, Zoom to Selection
T
= D Feal |5 ’_ Enable Overlappmg
T3 BEring to Top
B Zend to Bottom

Hydrophobiciny B
indices atph 34 =
determined by

I e —

HPLC |
Hydrop athicity

Biroad cast Selechion

Edit Pane Layout. .. 2
Maximize Pane Alt-Fa ;|
Bwitch to Seguence Pane FA
I
. FoREd B E
i
1. BioPlot F ### !
a.*> & Pane 2 # [f]> File>Print - 5 258 p 222 7B 2 50
b.*>* % Pane 2. #@éEditéCamera (<)
Camera 2_ # iy 5 #-F AL G T pEE P 7 B sl & 2 4250

4 Word > PowerPoint % i& {7 % {8 o

2. A2 H G P2 475 WA R PR Y T 0 Camera 2 ¥ i R
PR & Sl o R 02 R E P2 Pane 5 A e
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¥ ~ % ContigExpress

— . Introduction

ContigExpress * »%/] # B R 7] B it » 7 1RS> F fh e 4 d
automatic sequencer ’—"L’rﬁ%l MR T B REFAY S A B 5
B AL “contigs”.
“73 “contigs” 'y ¥ E 4% Vector NTI ¥ B fc > ¥ # 51 £ 7|7
e77’BLAST Search” #- data B3I WWW # gi7t *ijr

This tutorial can be completed in one session or divided into three
sessions as noted. At the end of this tutorial, you will be able to:

Create a ContigExpress project

Navigate and manipulate the CE Project Explorer window

Assemble contigs

Edit fragments and contigs in the Fragment Window or the Contig Window

Follow the steps of the tutorial in the order shown. Figures show what your
screen should look like at various points along the way.

— . Project Explorer

1. Add fragments to the project
ﬁg] MR E D ET A L
A% ﬁi%l ~ pF > ¥ U jE_ Add Fragments 2t pF € 1 IR 4ot & o
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st Project
Edit ¥iew Agemble

Align

Analyze Tools Help

= Open Project... Cirl40 B & | o == == EH '
o et BT B2 & X (= |EICIEE] 2 =EHE =X
i ame tatns £ Tt
| Ctrlts = TS T Origialls T 5T
Save bz
Eevert to Saved Praject
From GenBank file. ..
Export Item 3 From FASTA file...
Convert Contig to Fragment From ABI file...
Dizmolve Contig From SCF file...
Print... CiliE L A,
. . From EMBL file...
Print Preview .
. From Text file ..
Print Setup... )
From EZD file...
1 DemoPraject

2 DemoF roject?

Exit

>

PUREY R Pp b R RV EH S B4es 0 iE 3% ”From ABI file”

Import sequence from

HE|

Lok, i I _ 4 Demo Projects

] balBd1.ahi ] balBd5. abi

& balBd11.abi #] balBd6. abi

& bal6d12. abi #] bal6d7. abi

] bal6d2. abi ] bal6da. abi

1] bal6d3. abi 1] bal6d3. abi

] bal6dd. abi ] Rb. ahi

File narne: IS amnplel 303, abi Open I

Filez af twpe: I.-’-'-.BI files [*. abi)

j Cancel |

Fig. 17. 1

Note: Sometimes

list).
2.
T 5 51]@?] IN

.
2%

(R4

TR A R

the names of the imported fragments do not
directly correspond to their original file names — ContigExpress assigns
names that can be found inside the imported files to the newly imported
fragments. (In this example, Samplel303.abi becomes xb-control on the

Examine the CE Project Explorer window.

> wE N RAet Fow
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& ContigExpress Project - <DemoProject => M= E
Project  Edit Wiew Agsemble Align Analyze Tool: Help

EEIE A -l

[Hist

s 3E[:E

LY |

‘13 fragment(s) in project

Narne

= balbdl.abi
= balbd11.ahi
= balBd12 ahi
= balbd2.abi
= balkd3.abi
= balBdd.abi
= halbd5. abi
= balBd6.ahi
= balbd?.abi
= halbd8.abi
= balBdd.ahi
= RB1

= sh-control

|1 3 fragments 4

Fig 17.2
3. Create Assemblies of Contigs
EHP RS RS RES AL

Algorithm
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Pairwise ® best for assembling ten or fewer

fragments

Assembl o
ssemb y ® faster initialization

® Jower memory use

® may be faster for small numbers of
fragments

® more stringent default conditions

® user can set more assembly
parameters; allows higher degree of
assembly customization

Linear ® best for assembling 11 or more
fragments

Assembly ® slower initialization
® higher memory use

® faster assembly of large number of
fragments

® less stringent default conditions;
may allow assembly of fragments
with smaller regions of overlap

® fewer parameters to set; only
Minimum length of any overlap
parameter is used

T—‘g"f‘l(ﬁ). /i,'EI: ",f/’—@f’;/ﬁ//lm/[ﬁfl&;ﬂ’g 4\7%0.

PR

X154 A AT R % T AT B 5 "Contig 17 £ ATE e
)qug,\° J- ’F

4
BB “contig 170 BF € 41 IR 4w
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(=s] Contig Edit ¥iew Align Anelyee ALsemble Took Window Help

=R =R
ElE R E R =

[# Contig 1 (2 fragments)

1 General Description
(1 Fragments hatBdd.abi: 274 7708 (complementary)

ATE Hi— —N

o

bal6ds abi 1 7437

320 330 340 350

PhalBddabi| 40lc c T G cC & A & A T T T &G A T T T C AGHMATGAGAA EALCTGASAAATASAI]

GCTGCCAAAATTTAGATTTCAGHMAA-AAACTGAAALATAA T

MNJIc c T GCccCcaAa s s ATTTAGATTTCARGA ASA®SAA AAAALAZDCTGAAD-A-ATASAI

A‘_‘.._AJ AN G A Aoy

- L i YL - = B i Ao T ey e
G CTGCLCAA®AGATTTAGATTTCA ARG SAZA AEGSASASALLTGAAAAT

LT T R B R AE B R ik o

= . Working in Fragment Window

1. Open and inspect the Fragment Window
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i ContigExpress - [bal6d12_abi] [_[Ol =]
B Fragment Edit View “Window Algn Analyze Assemble Tools Help == =]
[ & % B & [o) o [ @ B2 SN2

IEEERIEEEE

CTGCA GGTCG ACTCT

GCCAT NCGGL CTGCC
TCCCT TCCTT TAGCC

%] bal6d12.abi (434)
=3 General Description
DMA Linear 434 BF
Creation Date: 05:31 PM January 11,1539
= & Chromatogram Data
Gel File Mame: Hard Digk: 3734 Software: 10aug. 3am
Start date of the gel run: 0B:29 AM August 10, 1993
Stop date of the gel run: 01:49 PM August 10,1333
Scaling factors for the average signals: &: 277, C 111, G: 425, T: 470

TGGAG

Fragment
baledi2.abi

® Text Pane

F4 B2 3mmin? (B pF o General Description & % s B 7
PR AFH > T UEERELS 7 B oy i o Chromatogram Data
#. data j¥_Sequencer $i5 11 pF e p B EERF 5 H 2 T gD o

® Sequence pane

PFBBEIRT HpF (%)E‘:g NIEFRE S v EEHE
g gt (), R kR E 2
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i@ ContigExpress - [balbd12 abi =]

B Fragment Edit Wiew Analyze Align Tool: Window Help

| ¥ ERs claER S
J’g%} |Jﬁ|ﬁ H|L—?€|’§|r’:ﬁ'¥w\‘,@ |‘§||EnurierNew j|13 j|B I &
1! 1 GCTTG CATGC CTGCA GGTCG ACTCT AGAGG ATCCC TGTTS CAATS TTTTC
=) CGALC GTACG GALCGT CCAGC TGAGA TCTCC TAGGG ACAAC GTTALC AALAG
= 51 MNTTAG AGCTG GCCAT NCGGA CTGCC AGACG TCCGG GTATC CGANT TTTTG
MNAATC TCGAC CGGTAL NGCCT GALCGG TCTGC AGGCC CATAG GCTHNL ALALC
______ 101 GCATC CGGAT TCCCT TCCTT TAGCC ACGGC CACAT AGTCC CCACA TTTCA
CGTAG GCCTA AGGGA AGGAA ATCGG TGCGG GTGTAL TCAGS GGTGT LAAGT
______ 151 CAGTG AGGCG CGGAL CCCAG AAAAT GACCG GATAT ACGCT ACCAT RATTT
GTCALC TCCGC GCCTT GGGTC TTTTA CTGGC CTATA TGCGAL TGGTA TTALAL
______ 201 TCAGC ATCAT TTGCC ACCCT TGGAG TCTCC GTGTA CATAL TAGCT ATTAT
AGTCG TAGTA AACGG TGGGA ACCTC AGAGG CACAT GTATT ATCGA TALATA
______ 251 AATAG ACGAC ATTGC TGGTG ARATC GAGGA ACTTA AGRAT TARAAR ACTAE
TTATC TGCTG TAACG ACCAC TTTAG CTCCT TGAAT TCTTAL ATTTT TGATT
______ 301 TGTGE TTTTA TGTAE AARCK ATRAM GTTTT ATTTT TCALAL CGTGA RATTG
ACACT AMAMAT ACATT TTTGT TATTT CALAL TAAMA AGTTT GCACT TTALAC
______ 351 ATGTT CCAAT TTTCA TAGTT GAAAA ARAGT TTGAG GGGGG GAGTT CRATG
TACARL GGTTA AAAGT ATCAL CTTTT TTTCA AACTC CCCCC CTCAAL GTTAC
______ 401 GNAAT ARAAT TTATT TATTC CCRAT CTTCA Arkk
[T EE— CNTTR TTTTR MATRAE ATRAG GGTTA GRAGT TTTT .

2. Sequence selection techniques

In ContigExpress * = fBLiE B 7|pF > 34§ cht T > € WA
I i S - £

Position box

AT CTTJA Apph

Pds: 51./51 / P

Selection box

» ¥ i% 18 ’selection box” & :}%ﬁ%l r»NITRFEBRTIE N R B o

Set Caret Position |

Gota: |1a1| bp OF.

Cancel

[T Do mot count gaps

Click on the Selection box on the Status Bar, opening the Set
- 56 -
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Selection dialog box. Set the selection to 10 bp — 30 bp and press OK:

Set Selection |

Erarm: {10 bp k.
To: |30 bp Cancel

[T Do rot count gaps

The selection is highlighted in the Sequence Pane and shown in the
Selection Box on the status bar:

i ContigExpress - [bal6d12. abi =] [_ O] x|

E Fragrment Edit View Window Aligh Analyze Aszenble Tool: Help ;Iilll
EEEEEREREIEEEIL
|BEE [|&6 8= s&emo | ome CF e 25
1 C b s CT I TGTT: CAATG TTTTC
51 MNTTAG LGCTG GCCAT MCGGL CTGCC AGACG TCCGSE GTATC CGANT TTTTG
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3. Translate the nucleotide sequence

i ContigExpress - [bal6d12_abi =] [_[Ol =]
B Fragment Edit View “Window Algn Analyze Assemble Tools Help == =]

I RN =
J’E%} J:ﬁ o 'H‘|’:| AR L @ |§||CourierNew jITS j| B I &

%] bal6d12.abi (434)
=3 General Description

TGTTG CAATG TT =]

DNA Linear 434 BP 51 MNTTAG AGCTG GCCAT NCGGA CTGCC AGACG TCCGG GTATC CGANT TT
Crealion Date: 05:31 PM January | MAATC TCGAC CGGTA NGCCT GACGG TCTGC AGGCC CATAG GCTHA AL
101 GCATC CGGAT TOCCT TOOTT TAGCC ACGCOC CACAT AGTCC COACA TT
Giel File Mame: Hard Disk:3734 Sc | oo ... COTAG GCCTR AGGGR AGGAR ATCGG TGCGG GTGTA TCAGE GGTGT Rh
Start date of the gel tun: U5:29 A 151 CAGTG AGGCG CGGAL CCCAG BAAAT GACCG GATAT ACGCT ACCAT A
Stop date of the gel run: 01:49 Pk | ¢ GTCAC TCCGC GCCTT GGGTC TTTTR CTGGC CTATA TGCGA TGGTA TT
Scaling fantors Far the average sig 201  TCAGC ATCAT TTGCC ACCCT TGGAG TCTCC GTGTA CATAL TAGCT AT

AGTCG TAGTA AACGG TGGGA ACCTC AGAGG CACAT GTATT ATCGA TA

251 AATAG ACGAC ATTGC TGGTG AAATC GAGGA ACTTA AGALAT TALLL AC

Fragment
baledi2.abi

Pos: 141 Sel: 141 : 30430 =57

EB- A F R0 5T I g ad () an e
WA S A ( (). F » F R

\

J i Hgﬁ Fray H’F‘é|%|%”§w"‘,@ |‘§||CourierNew I'\B J|B 1& |

%1 bal6d12.abi (434) o Ala Cys Met Fro  Ala Gy Ag Les ™ Aig =

= ‘-3 General Description 1 TGTTG CALTG TT
DM Linear 434 BP ACRAC GTTAC R4
Creation Date: 05:31 PM January || 1 Ser  Als His A Cys Thr Ser G Lleu Po

= & Chromatogram Data 51 NTTAG AGCTG GCCAT NCGGL CTGCC AGLCG TCCGG GTATC CGANT TT
el File Mame: Hard Disk: 373 5 NLLTC TCGAC CGGTA NGCCT GACGG TCTGC AGGCC CATAG GCTNA Ak

g (M) erE3Ez3 AR REE FI7 (@) [an

“eraser”]. i "% 3B AT IRA o,

2LiE (FI) ﬁ} ¥ 7|2 17 ORF 3R] » 4o ]
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Fragment Edit View Align Analyze Assemble Tools Window Help

4o % 34 7 ’DELETE” 45 £ 2=

S —~T —
EEAa =
o= ATE | g —-N I+l || ATC | b '»: G Ul AL
| | E2] | uTc|Tu5|ﬁr =5 FaE Q|§||EDU"E'“EW =l = B F Q’.
ERESY !
HE:I 1 TGCAT GCCTG CAGST CGACT CTHNGA GGATC CHNCTT ATTGC TChilk AAGGT
=] i -1
51 NACTC TATAL GRALA CAATC AAGTT TTTCA ATaLL TGTTT GTCAG ATCGG
+1
101 AGAGA MNGAAC Gﬁ*}GA CTCTC TTGTC ARATT TGGEAG CAATT ATTGC TCAAG
-1 135bp
151 GACTT CTCGA CATCG GAGGS CAGLAL CGCTS MGGTC ALCLRAT GChil ATTCT
__________
e
+1
201 GACAA GCAGC MAGAT ATGSS ATCAL TGESTC GCGAAT GATGT GCTTC CTTCA
__________
251 CGGAT GGTTC TGGCA CTCGA TGCAT TTCTT CATCG CCCTT GCTGC TAAGC
__________
301 CATCA TGCCT TGTGA TGATGE AMCGL GLATC ToALG ATTCC AGTAC TTGAC
351 TACAT CTGCC ATGCC AATAG TCAGHR AGTTT GCCTA TCCAC CACGE GCCGR
401 ATCRA RAGAMG GATAA GGATG TCARA MAGAT TGAGL CTAR

s AR

F RS 7GR
RS TR (V) T R
|
1 GCTTG CATGC CTGCA GGTCG ACTCT AGAGG ATCCC TGTTG CLATG TTTTC

GRCC

PR AE g ATIE @
% 4 € iR o '_E_}?g.}ljg 12 () %
¥E > EE P T B A s
2z » - Chromatogram data ® > }* % 3
BdesS BN g Vg e B o7
PR ARG ETRT S
g # o
_59.
RERFL S PHLRG AP

R e

xS R ) R
Rl e T

r 2 99

7gap”

At GGA g » 1B TAAY
M Y% B~ g - -&r.ﬁi::ff;: -3 =3 | Ny
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GUITG CRIGC CLGCA GGICG ACTUL AGAGG L1TCC TGILG CALLG TTIIT

[#] ba16d12 abi (434)
(3 General Description

@ Chromatogram Data
TTTAG GATLL [lGGA TATAC GCTAC CATAL
T & & chcc

TTCCC AATC

G G oA 1

Fragment
BaTEIZ 30

5. Analysis the Sequence via BLAST
%ﬁ d %+ > 1 &5 ¢ 5>Tools>BLAST search, * ¥ ¢ 1) -

3 EERE
sequence Data x|

€ Eelection Cnly etz |

) Curent CIE feahre

— ratramd
f+ Direct
{~ Complementary

8L P0K” ) oY B i 5 511@'] ~ 3 ”BLAST search”# st ® >
2

WF I THOF L 0 o

7= . Working in the Contig Window

Selecting and opening a fragment brings up Fragment Window.
Selecting and opening a contig, opens a Contig Window.

1. Open and examine a Contig Window.
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%‘ﬁ“s! B Ex— BContig” 4 2 B i3 & BAL T 45 B e 4 o7 & i
% o

i ContigE xpress - [Contig 1] M=l B3
|=a Contig Edit MWiew Align Analize Assemble Toole Window Help —1&lx]

IR =Y
[E=t=0

[‘f:l Contig 1 [2 fragments) " :I
] General Description balBdd.abi: 274 « 708 (camplementary)

(1 Fragments ba16dg.abi 1 » 437

S50 jo0 50 00 @50 00 @0 400 @50 500 ss0 poo s Top v
I

« balbdd.abi 1

Contig 1 Il c T TeocaTTGeGooTGCoAGGTOCGATLCTCOCTSAGATGTE G ATOCTGLCH
=1 |
=157

® (Graphics Pane

Click the Contig Graph button (@) in the Window toolbar to
activate the Graphics Pane.

The Graphics Pane contains horizontal arrows representing the
relative positions of the fragments forming the contig. The arrowheads
indicate the direct or complementary position of the respective fragment.

BT Y ohE A% 270 base I - BUgap” v i AT
assembling P¥F 3 & 7| 1IR3 "match”Ih % > 2 B A4 ¥ ¥ 5 quality
control =& 5 ©

balGddabi 1 437

295 350 355 260 765 D70 775 760 765 290 295 300 305 M0 315 320 335 2omys v

AGAGDAC TEGTTTAGGATAACCGAAAGCATTTITCT
[GTTCTTGTATTGC T I\ GAGAC TGEGTTTAGAATAACCGALAGCATTTTCT
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2. Review the contig in Contig Alignment Pane

miE (B s & 2 s

ragment current |
piosition /—Sca &

I I I AR AS

ragment current | TTA
piosition /—Sca &

250 . j
T & A8 & G A A ImEl A T G A A C TGO C T T LCa [-
) - \ P A e N
Vo o . -_..Ir‘l-__,‘_a.\lf»{x f{ "
4 W L - .Y b f \f J .
" ANXIN NI NN 2
i A T G A ACTBET TE
» ba]5d.ani | McE
Ilg'l 46T T A T A A A G A A T T TGHW TEAALCTGLE T TC j
L \_,_ ] M
ragment names ONSENSLE ragment sequence

list FEOUENCE {partislly zelected

® The fragments names list contains all fragments used in this
contig

® The scale gives a reference for all fragments and the consensus
shown in the alignment

® The fragment current position is the relative (counted from the
fragment start) position of the currently shown left end of the
respective fragment. A dot (e) is shown to the left of the position

if the fragment is completely to the left of currently displayed
area.

3. Exit ContigExpress

Now you have finished the ContigExpress tutorial.

Close ContigExpress as you would close any other Windows
application.
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. Introduction

Vector NTI Tools

Vector NTI suitell #-#% /i % Entrez/PubMed search # & I % i

2 g R

=

3 Sy

{5 PE B ATIR A chid 8 ATAE S

. PubMed/Entrez Search

L5
{ #7H5S NCBI
%+ ”Database Explore

ﬂ@ﬁ@)ﬁk;ﬁﬁv o

pEI1E

7~

2

L, vl P2 5L
‘%—ﬁ?‘:ﬁ m@ 5Z 0

ﬁ%lﬁié%ﬁﬂﬁ#@&‘ﬁﬁwaﬁi’@
’#ﬁ‘a?“gr“]NCBIm{ﬁv

% #2# NCBI 74

e =X

A’ R

2% (G

B 4> Vector NTI Suite 7> PubMed/Entrez Search (@)

& Untitled - Pubmed/Entrez Search JH[=] E3
Seach Edit Miew Algn Analyze Assemble Tools Help
u 1 By
= = | BP
Mew Open Save Sy hdz Help Back  Faomwad  Efop
J Database IPubmed 'I & Search
"Feliz catus" [Qrganism]
OR  cat[Test'word]
“"Canis Farniliaris" [Drgarism]
AND
| OF  dog [Test Word]
|
Id | Author | Title | Source | Language I Impriit Date «
[ 10795405 Individual identification ... SciJustice Eng 1999 .Jul39(3 1671, 1999,
(B 10773624 Cross-species and intras Brain Behaw Ewol Eng 2000 Jan55(1):37-43 2000,
07E4836 Species-specific variatio..  Glycobiology Eng 2000 Mayw 105477, 2000
0756554 [Elimination of sitbarne a...  Fev Mal Respir Fre 2000 Feb17(1):29-39 2000
0753087 Socioeconomic Predicto.. Environ Health Perspect  EMG 2000 Apr1084):301 2000,
10737300 Pet Travel Scheme:, Vet Rec Eng 2000 Feb 26:146(9y... 2000
0731175 Recognition of televisio..  BMJ Eng 2000 War 25:320(72.. 2000
0730705 The effects of periopera... et Surg Eng 2000 Mar 2921123 2000
£ 10730626 Comparizon of needle-c. J Am Anim Hosp Assoc Eng 2000 Mar;36[2):153- 2000
0727842 Detection of twpe lll sec... Vet Microbiol Eng 2000 Mar 15;72(3-4).. 20007
£10723604 Hydromorphone: a cost-..  Can'Yetl Eng 2000 FebA1[2):135-.. 2000
210714648 Distribution of cells immu... et Pathol Eng 2000 Mar:37(2168- .. 2000
070188 Capillary blood sampling ... J Small &nim Pract Eng 2000 Feb:41[2)60-66 2000
£] 10693023 Molecular identification ... J Clin Microbial Eng 2000 Mar 3831123 2000 _
"""""""" - o : a0 _'Ei
[ |20 of 4895 HUM i
PR —7
Database if # 7
® (itation-~ /]%
N P [N 2 AN 1 1
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® Nucleotide- & & 71
® Protein- % AfE 7|
® Structure- F-v " 3-D B4/ 7] B9
NOTES: #F##0F = 507 0o g~ {0 & D sh e dh o 4 -

EEHE S AR B FS /n\vvuﬁg?lxpiﬂ% 1

AL 5 E TS
PP EEREAROF R T - B N

#7ENTER” » ¥] %
# SPACE” T ¥ .

gg‘rﬂg_ﬁy%ﬁpﬁ y ?«?lj’% 3“3,_'—*“]-:5-7»%& OI’,AIldOI'NOt E‘f"ﬁ‘igﬁ" B
7R F o

® Defining Search Conditions

Before you initiate the search, select Edit—>Settings, opening the
Settings dialog box.

Settings
— Commaon - Publication date
Documents per pags |E _|:i' ' From [ May10/2000 [ 2 to | ay/10/2000 > [
Histary buffer contains|2l] _|::| quernies  Relative |3U _,;'
™ Save results slong with document * iy
— Internet aptior — Entrez date
W Access tothe Intemet using a prosy server " From I May10/2000 Llj ® I Map/10/2000 Llj
Address: |hpro:-cy Port: |BD " Relative ISD _lj
% fpy
oK I Cancel I

FH = 167 #-% % Check the Save Results... ® 74 °

The History buffer contains the last queries and query results. You
can move through the history by using Back and Forward buttons.

Internet K T4 ¥ F RFR L L 0 FPFEAlE o

In the Publication Date section, enter publication dates to narrow the

search to a certain date range. In the Entrez date section, enter acceptable
molecule submission dates.

Click OK to return to the PubMed/Entrez Search dialog box.
When you have entered all search conditions, press the Search

- 64 -
RMFREA S FHEB>F LT Copyright 2003 All right reserved



Vector NTI User Manhual

button (@). The search results are displayed in the list pane in the
bottom half of the dialog box.

® Reviewing Search Results

Article or molecule summaries are listed in the Results Pane. There
are several techniques to download the citation or molecule results:

Double-click on its identification code for the selected object or
select multiple objects

Select Open DNA and Protein #-2 3> Vector NTIAL & # TR @
< LF”& e’ Abstract”$R & #- % 3.3+ Citation Viewer”.

Select Export from the shortcut menu to download the selected item
and places it in a file you specify.

Drag and drop selected object(s) from the Results Pane into
Database Explorer or Windows Explorer folders.

FEMATRIROTHE S LEP > L EF R B ERE T
s fe A ¥ RIRA K o,

® Saving Search Results

g & * HE* SaveAs MR N B RE LA DG G @ 2L
PEFRFRAFHETLILGS TR BFRERG  1 3
_P = th>”Search”> Result> Open/ Save to...? » JLpF € J 4o 47
L7 H,

-u \
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{Z5E - Pubmed En

Seerch  Edit View Help
[ Hew Parsmeters  Cl+ll E | %% | %‘?
ey Windoue
Dq' Open Parameters. .. Chl+O 3 ﬁSeaIch

[ Save Porameters  Ctl+d
Bave Parameters Lz

ToDE 14 4r

Eerent File Exort io Fﬂ.e -
| Tifle | Source | Languaze | Imprint

CpG dsland hypermethyl . Oncogene eng 2002 Aug 1221635},
Wong MPetal Primary adenocarcinom...  Cancer Res eng 2002 Avg 1HZ{15):..
ChenH etal. Hypenmethylation of the...  Chin Med T (Engl) eng 2002 Il 11507087,
Foncalli M etal. Methyvlation framewark ... Hepatology eng 2002 Avg3a(2)427.
Kaveakami K et al. A came of acute morelodd . Int J Hematol eng 2002 Jul7a0l).80-83
Thompson BT et al. Developmentsl regulatio...  Pflugers Arch eng 2002 JulA44i4).539.
Koschny B etal. Comparative genome b, Cancer Genet Cytogenet  eng 2002 Jun;l 3502514
Kubova H etal Domamic changes of stat...  Epilepsia eng 200243 Suppl 5:54-
Kang ¥ etal. Altered expressionof (¢, Carcinogenesis eng 2002 Jul23771217.

Qian X et al. TGF-E and Estrogen Re...  Endocr Pathol ENG 1097 £(31:241-250

Lloyd BV Grrowth Factors. Endocr Pathol ENG 1097 8(20121-127
Grarcia-Manero G etal DA Methylation of Mu... Clin Cancer Res eng 2002 Ml8(72217-..
Glerant JC et al. Effects of tntermittent ne... Chest eng 2002 Jul;122(1309-
] Taketani T etal. The chromosome translo...  Genes Chromosomes C... eng 2002 Aug;3d (43437
12112524 CooleJetal Identification of novel £, Fenes Chromosomes C...  eng 2002 Aug;34(4):354 .

3
I | Auihors |_Title | Journal | Date |
12154405 I Estellar Cplt island hyper.. Onoogene 08-02-2002
12154056 MP Wong etal. Primary adenocar...  Cancer Fes 08-02-2002
12150726 H Chenetal Hypermethylation...  Chin Med JiEngl)  08-01-2002
12142052 I Roncalli et al. Methylation frame... Hepatology 07-26-2002
12135901 K Kawalamni et al. A cameof acute ... Int T Heimatol 07-25-2002
12138274 RIThompsonetal.  Developmentalre...  Pflugers Lrch 07-23-2002
12127309 R EKoschy et al. Comparative geno... Cancer Genet Cat... 07-19-2002
12121206 H Kubaovi# etal Domaimic changes .. Epilepsia 07-17-2002
12117781 ¥ Kangetal Altered expression...  Camcinogenesis 07-15-2002
12114729 X Qqanetal TGF-B and Estrog...  Endocr Pathol Tul-12-2002
12114632 B Llowd Crrovwth Factors. Endocr Pathal Tul-12-20032
12114423 (3 Garcia-Manerw . DNA Methodation ... Clin Cancer Fes 07-12-2002
12114344 IC G lFrant et al Effects of tntermdt..  Chest 07-12-2002
12113533 T Taketani etal. The chromozome .. Genes Chromoso.. 07-11-2002

Cipen | Canecel |

”Import””‘Jr— #-¢ ¥ #:i& » "Database Explore”p ¥ /&
£ 70Open”f| ¢ #or3 TRl 5 AT B3R o

®
ﬂ_eﬂ
m ﬁa

= . Citation Viewer

Vector NTI suite II # & ¢ Citation Viewer ¥ & % < jk ¢
&7’ Abstract’3R 4 > F 4L 0¥ o “Database Explore”® 1 Citation F
& » & §_d PubMed/Entrez Search & % ﬁi%J »

To open Citation Viewer, select Citation Viewer in the program
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group or folder where you installed Vector NTI. If opened from
Database Explorer, Citation Viewer is empty and must be loaded from
other sources, listed below:

From the PubMed/Entrez Search results, or from the Citations Table
in Database Explorer, drag and drop citations into Citation Viewer. It
helps if all of your screens are in “Partial Screen Size” to do this. 1f you
transfer multiple files, all of the abstracts will open in Citation Viewer.
You can alternate between references by pressing the Back and Forward
buttons on the toolbar (they resemble the Back and Forward buttons on
your Web browser) or you can select from the list of open citations under
the Windows menu option.

® Opening Citation Viewer

You can open an individual citation into the Citations Viewer
window from the PubMed/Entrez Search display window or from the
Citations Table in Database Explorer. Simply double-click the entry in
either location to load Citations Viewer.

Citation viewer registers its file types, so doubleclicking on
some .cab, .cq or .ct file in Windows Explorer will cause Citation Viewer
to run and open that file.

¥l Cation Viewer - [10795405%; Individual identificstion of cats and dogs using...]

) ik B Wiew Algn Ansben fsvenible ook idow el el =
Open  Saveds Comers | ik Preview | Daisbose el | Tl Abubact

.; 10735405
A General Inframatinn Sci Justice 1999 al-Sep 39(3):167-T1

Individual identification of cats and dogs using mitochondrial
DNA tandem repeats?

= _d Pubhiatim lype
JOURNAL ARTICLE

3 Citation

= fatiche Wle
ndevidusl identification of cats and dogs using mitechond
2 Auticle authors

Tridez T, Rochat §, Coquoz Rt

Instinat de Police Scientfique et de Cnmmologe, Unnversity of Lausanne, Banment de Chimee, CH-1015
Lausanne-Dorigny, Switzerland.

Fridez F .
jnw’m 5 [MEDLINE record in process]
_ACoquoz R . . ) . o
Cats and doge are very common ansmals in the human In one mn five owng

Affistion Instht de Police Scientifique et de Criminclagie acat or a dog. Their hairs are v

easdy transferred and could be used as a frequent trace evidence. Using
4 be po .

# LI MuSH tems ERID: Q010795405, UL 202555368

+ [ Chemicals list Publication types:
JOUBNAL ARTICLE
e L]
Resdy HUM

® FElements of Citation Viewer
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The Citations Viewer display window shares many of the same
features found in other Vector NTI Suite applications:

The window title bar displays the name of the open object.

Click the maximize box (g) in the upper right corner on the title
bar to maximize the window, filling the entire Vector NTI workspace.

A display window is divided into two panes: a Text Pane containing
folders with descriptions of the citation such as author, source, and public
database identification data. The Abstract Pane displays the abstract for
the citation.

A vertical, movable split bar divides the two panes.

All Vector NTI Suite windows have a Main Menu and toolbars
where many different options and operations can be initiated. Most of
the toolbar buttons in Citation Viewer are similar to those you have seen
in other display windows. All Vector NTI Suite toolbar buttons are
summarized in Chapter ss of this manual. The toolbar buttons you will
use in this section are displayed when needed.

Back and forward buttons will bring up the previous or next viewed
document if it is still open.

Note: If the citation contains an URL to its full text or abstract in
the Internet, that URL will be displayed in Text Pane. Clicking on it
causes the default Internet browser to open to the appointed location.

The following feature can be performed in Citation Viewer.
Copying selected data to the clipboard

Exporting data to external programs

Printing data

Modifying the Citation Viewer layout

Saving data
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YO = > S BRI
1. # 4>—>48 3% # —Vector NTI suite—License Manager " F¥ ¢
M- B EARE

Wector N TI Suite 7.1 License Manage x|
RUMIMATY | Static license sethings | Dvmannic license sethings | Trial license settings |

— & pplications

Eioplo [Ftatic license
Vector NTI  [Fiatic lvense
Align® Fatic hrense
ContigErpress Et&ti;: licenss
Hpresson Et&ti;: license

Wector M TI Options: Yo can create shared databases for 10 nzers "

To npgrade a component from demo or tme limdted trial mode, please P
contact our sles and marketing department at the numbers listed below,
to confinm pricing and availability.

o mayr order a license npgrade for one or all of the component programs via
fax, emadl or phone. Simply send vz your PO, or credit card number, shipping ;I

Drganization; I Tri-I Bintech, Inc.

Phone momber: |+EEE-2-E?053433

E-mdl address: Ikgvmwang@td-ihiatech.cam.hv

Licenzs #: IKEUTM-EQDDE

Hard ware ID: |4-I5I]1'?-2192C

(et Begistration Eev From Inforkfax Web Server |

Eew: I

Apmly Fezet static livenss |
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pEF A 7Key”en g $a o Bh4E ~ "UNREGISTER”

Vector NTI nite 7.1 License Manager x|
Summery Statc license settings I Drmaimic hcense sethings I Trial license sethngs I

Wamme: IKevin Wang

Jrzanization: I Tri-I Biotech, Inc.

Phone mamber: |+SBE-2-E?053433

E-mail add ress: Ikzvmwmg@tfi-ihiutech.mm.w

License #: |KEIT.T‘5.FM-29EIEIE

Hawdware [T I4-EDI?-2192C

Cret Bepgistration Eew From Inforkfax Web Server |
kv [UNREGISTER
Lpply I Eezet static licenss I
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